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บทท่ี 1

Web Mail Samoware

CommuniGate Pro Messaging System เป็นระบบอีเมลท่ีให้บริการโดยเน้นการทำงานผ่านเว็บเป็น

หลัก ผู้ใช้สามารถเรียกใช้งานผ่านเว็บบราวเซอร์ (Web Users) บนเครือข่ายท่ีให้บริการ ด้วยการทำงานผ่านเว็บ

แต่สามารถทำงานต่างๆ ได้เสมือนเป็นโปรแกรม Clients พร้อมด้วยฟังก์ชันท่ีหลากหลาย

การเร่ิมต้นการใช้งาน

1. ทำการเปิดโปรแกรม Web Browser ท่ีต้องการใช้งานในเคร่ือง
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รูปที่ 1 การเรียกใช้งานโปรแกรม Browser Google Chrome

2. ท่ี Address Bar ใส่ท่ีอยู่ของระบบ https://mail.pawn.co.th

รูปที่ 2 แสดงการป้อนที่อยู่เพื่อเข้าสู่หน้า Web mail
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3. เข้าสู่หน้าแรกของระบบWeb mail ทำการป้อน Username (ไม่ต้องใส่ @pawn.co.th) และ Password

จากน้ันคลิกท่ี “Log in” เพ่ือเข้าสู่ระบบ

รูปที่ 3 แสดงหน้า Login ระบบWeb mail

4. เข้าสู่หน้าแรกระบบ Web mail

รูปที่ 4 แสดงหน้าแรกของระบบ Web mail
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1.1.องค์ประกอบของ Web mail

1.1.1.Available Modules

ประกอบด้วยเมนูสำหรับเข้าสู่ฟังก์ชันต่างๆ ในระบบ ซ่ึงอยู่ด้านซ้ายมือ

รูปที่ 5 แสดง Available Modules สำหรับเข้าสู่ฟังก์ชันหลักต่างๆ ของระบบ

1.1.2.Actions Bar

แสดง Actions Bar ท่ีอยู่ในแต่ละฟังก์ชัน จากรูปตัวอย่างด้านล่างจะเป็น Actions Bar ท่ีอยู่ในส่วนของ

การจัดการข้อความ

รูปที่ 6 แสดงฟังก์ชันย่อยของการจัดการข้อความ
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1.1.3.Current Module Options

แสดง Options ท่ีเรียกใช้งานอยู่ปัจจุบัน จากรูปตัวอย่างด้านล่างจะเป็น Options ท่ีอยู่ ในส่วนของ Mail

รูปที่ 7 แสดง Options ของ Mail
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บทท่ี 2

Folder / Mailbox

ใน Web Samoware จะมีเคร่ืองมือท่ีจะช่วยให้ผู้ใช้สามารถสร้าง Mailbox ได้ตามความต้องการ

อย่างง่ายดาย นอกจากน้ี ด้วยความสามารถ drag and drop ของ Web Samoware ยังช่วยผู้ใช้ย้ายข้อมูล

ระหว่างโฟลเดอร์โดยใช้วิธีการลากข้อความมาใส่ในโฟลเดอร์ท่ีต้องการได้อีกด้วย

ผู้ใช้สามารถสร้างโฟลเดอร์ได้อยู่ 2 แบบ คือ

1. Mailbox เป็นโฟลเดอร์ท่ีใช้ในเก็บข้อมูลท่ีเป็นอีเมล

2. Address Book เป็นโฟลเดอร์ท่ีใช้เก็บข้อมูลท่ีเป็นข้อมูลผู้ติดต่อ

จากรูปท่ี 8 ตัวเลขด้านหลังช่ือโฟลเดอร์ เป็นการแสดงบอกให้ทราบถึงข้อความใหม่ท่ียังไม่ได้อ่าน

รูปที่ 8 Mailbox

- INBOX: กล่องข้อความเข้า ข้อความอีเมลท่ีเข้ามาใหม่จะถูกเก็บไว้ท่ีน่ีเป็นท่ีแรก

- Drafts: กล่องข้อความร่าง ข้อความอีเมลท่ีถูกเก็บบันทึกไว้เป็นข้อความร่าง

- Sent Items: กล่องข้อความส่งออก ข้อความอีเมลท่ีถูกส่งออกไปจะถูกทำสำเนาเก็บไว้ท่ี

น่ี

- Junk: กล่องข้อความ Junk เป็นท่ีสำหรับเก็บข้อความท่ีเป็นสแปม

- Trash: กล่องข้อความ Trash เป็นท่ีสำหรับเก็บข้อความท่ีเป็นขยะ โดยข้อความท่ีถูกลบ

แล้วจะถูกส่งมาเก็บไว้ในกล่องข้อความน้ี
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การสร้าง Mailbox / Folder

ผู้ใช้สามารถสร้าง Mailbox / Folder ได้ตามความต้องการ ดังต่อไปน้ี

1. คลิก “ ” (เคร่ืองหมายบวก) ด้านบนซ้ายของเมนู Mail

รูปที่ 9 เครื่องมือที่ใชใ้น การสร้าง Mailbox ใหม่

2. คลิกเลือก “Create Folder”

รูปที่ 10 แสดงการคลิกเพื่อ Create Folder

จากน้ันกำหนดช่ือโฟลเดอร์ท่ีต้องการสร้าง และคลิก “Save”

รูปที่ 11 ใส่ชื่อโฟลเดอร์เพื่อสร้าง Mailbox ที่ต้องการ
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3. ในกรณีท่ีต้องการสร้าง Sub Folder ให้เลือก Folder Location ท่ีต้องการ เช่น สร้าง Sub Folder ช่ือ

Work ภายใต้ INBOX จากน้ันคลิก “Save”

รูปที่ 12 การสร้าง Sub Folder และการเลือก Folder Location ที่ต้องการ

Page 10



บทท่ี 3

การรับ-ส่งอีเมล

กล่องข้อความหลัก คือ โฟลเดอร์ท่ีใช้เก็บอีเมลขาเข้า ซ่ึงจะประกอบไปด้วยรายการอีเมลท้ังใหม่และเก่า ผู้

ใช้สามารถเข้าสู่กล่องข้อความหลักได้โดยไปยังเมนู Mail และเลือกโฟลเดอร์ท่ีต้องการ

รูปที่ 13 แสดงรายการอีเมลทั้งใหม่และเก่า

ในแต่ละอีเมลจะมีสถานะท่ีบ่งบอกถึงการเปิดอ่านเมล, ความสำคัญของเมล, ไฟล์แนบ และการกระทำ

ต่อเมล เช่น การตอบกลับ, การส่งต่อ เป็นต้น ซ่ึงมีรายละเอียดดังต่อไปน้ี

- แสดงสถานะของอีเมลท่ีเข้ามาใหม่และยังไม่ได้เปิดอ่านจะเป็นอักษรตัวหนา

- แสดงสถานะของเมลท่ีเปิดอ่านแล้วจะเป็นอักษรตัวบาง

- แสดงหัวข้อของเมลท่ีมีการติด Flag

● แสดงสถานะของเมลท่ีมีไฟล์แนบ

- Re: แสดงหัวข้อของเมลท่ีมีการตอบกลับ

- Fwd: แสดงหัวข้อของเมลท่ีมีการส่งต่อ
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ระบบ Email สามารถทำการ Reply, Reply All, Forward

- Reply : ถ้า A เลือก Reply อีเมลตอบกลับจะถูกส่งกลับไปท่ี B เพียงคนเดียว

- Reply All: ถ้า A เลือก Reply All อีเมลตอบกลับจะถูกส่งถึงท้ัง B และ C (หรือใครก็ตามท่ีอยู่ใน To,

Cc, Bcc)

- Forward : ส่งต่อเมลไปให้ผู้อ่ืน โดยมีไฟล์แนบต้นฉบับ

รูปที่ 14 แสดงการตอบกลับหรือส่งต่ออีเมล

3.1. การเรียกดูอีเมล (Read E-mail)

ทำได้โดยการคลิกตรงบรรทัดของรายการข้อความท่ีต้องการ โดยจะมีฟังก์ชันในการกระทำต่ออีเมลท่ีเรียก

ดู ดังน้ี

- Delete: ลบข้อความปัจจุบัน

- Reply: ตอบกลับข้อความ

- Reply to All: ตอบกลับท้ังหมด (รวม Cc ด้วย)

- Forward: ส่งต่อไปยัง

- Redirect to: ส่งข้อความต่อไปยังผู้อ่ืนท่ีต้องการ

- Uudecoded Message: แสดงข้อความ Header E-mail

- Print: ทำการพิมพ์ข้อความท่ีเลือก

- Move in to… : ย้าย หรือคัดลอกเมลท่ีกำลังอ่านอยู่ไปยังโฟลเดอร์ท่ีเลือก

- Toggle Flagged Status: ต้ังค่าข้อความให้ติด Flag

- Toggle Read Status: ทำเคร่ืองหมายว่ายังไม่ได้อ่าน
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รูปที่ 15 แสดงการอ่านข้อความอีเมลทั่วไป

การสร้างอีเมลใหม่ (New E-mail)

ทำได้โดยการคลิก “New Mail” ซ่ึงอยู่ด้านบนของหน้าต่าง Mail ในส่วนของการจัดการข้อความ

รูปที่ 16 แสดงการสร้างอีเมล

ซ่ึงจะประกอบด้วยการใช้งาน ดังต่อไปน้ี

- To : ระบุช่ือและท่ีอยู่อีเมลสำหรับผู้รับ

- Subject : ระบุหัวเร่ืองของข้อความ

- Toggle Important : ระบุระดับความสำคัญของข้อความ

- Rich formatting : เรียกใช้ฟังก์ชันการเขียนข้อความแบบ Rich Text เช่น ตัวหนา, ตัว

เข้ม, ตัวเอียง, รูปแบบของตัวอักษร, สีอักษร, การแนบรูปภาพ และการแนบลิงก์

- Formatting : เรียกใช้งาน Format Style ของข้อความ

- Font Color : เรียกใช้งานเปล่ียนสีตัวอักษร
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- Bold : เรียกใช้งานทำให้ตัวอักษรตัวหนา

- Italic : เรียกใช้งานทำให้ตัวอักษรตัวเอียง

- Underline : เรียกใช้งานตีเส้นใต้ตัวอักษร

- Deleted : เรียกใช้งานขีดเส้นระหว่างกลางตัวอักษร

- Align text to the Left : ให้ข้อความชิดซ้าย

- Center text : ให้ข้อความอยู่ก่ึงกลาง

- Align text to the Right : ให้ข้อความชิดขวา

- Justify Text : ให้ข้อความชิดท้ังสองด้าน

- Unordered List : ใช้ในการกำหนด หัวข้อ และ รายการ แบบมีลำดับโดยใช้สัญลักษณ์

- 1. Unordered List : ใช้ในการกำหนด หัวข้อ และ รายการ แบบมีลำดับโดยใช้ตัวเลข

- < Outdent : ใช้ในการย่อหน้าตัวอักษรให้ไปทางซ้าย

- > Indent : ใช้ในการย่อหน้าตัวอักษรให้ไปทาง

- Link : ใช้ในการแทรกลิงก์ลงในจดหมาย

- Insert Image… : ใช้ในการแทรกรูปภาพลงในจดหมาย

- Table : ใช้ในการแทรกตารางลงในจดหมาย

รูปที่ 17 แสดงการเขียนข้อความอีเมล
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บทท่ี 4

Web Samoware Function

Web Samoware เป็น HTML5-based Client ท่ีสามารถทำงานบนเว็บบราวเซอร์มาตรฐาน เช่น

Internet Explorer, Mozilla Firefox, Google Chrome ฯ ซ่ึงใช้เทคโนโลยี HTML5 ทำให้การเรียกใช้งานเป็น

ไปอย่างราบร่ืน เสมือนว่ากำลังใช้งานโปรแกรมบนเคร่ืองของตัวเองอยู่ ใน Web Samoware จะประกอบไปด้วย

ฟังกัชันระบบอีเมล, สมุดรายช่ือผู้ติดต่อ (Contacts) ฟังก์ชันสําหรับการสําหรับการทํางานร่วมกันในองค์กร เช่น

ตารางนัดหมาย (Calendar), ระบบโทรศัพท์ (Call), และฟังก์ชันเสริม พิเศษอ่ืนๆ เช่น ไฟล์ (Files)

4.1. สมุดรายช่ือผู้ติดต่อ (Contacts)

ผู้ใช้สามารถเข้าสู่รายช่ือผู้ติดต่อได้ โดยคลิกเมนู “Contact” ท่ีเมนูด้านซ้ายมือ

รูปที่ 18 แสดงเมนูรายชื่อผู้ติดต่อ (Contacts)
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4.2. การสร้างสมุดรายช่ือผู้ติดต่อใหม่

การสร้างสมุดรายช่ือผู้ติดต่อใหม่ สามารถทำได้โดยคลิกเคร่ืองหมายบวก ตรงด้านขวามือในส่วนของ

ฟังก์ชัน Contacts และเลือก “New Contact”

รูปที่ 19 แสดงการสร้างรายชื่อผู้ติดต่อ (Contacts)

ซ่ึงในหน้าการเพ่ิมรายช่ือผู้ติดต่อใหม่ จะประกอบไปด้วย

- File As : ช่ือผู้ติดต่อใหม่

- Title : คำนำหน้า

- First Name : ช่ือจริง

- Middle Name : ช่ือกลาง

- Last Name : ช่ือนามสกุล

- E-MAIL : อีเมล ซ่ึงสามารถเลือกประเภทให้เป็น Home, Work ได้

- TELEPHONE : เบอร์ติดต่อ ซ่ึงสามารถเลือกประเภทให้เป็น Home, Work, Cell, Fax ได้

- ADDRESS : ท่ีอยู่ของผู้ติดต่อใหม่ ซ่ึงสามารถเลือกประเภทให้เป็น Home, Work ได้

เป็นต้น ฯลฯ
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รูปที่ 20 แสดงรายละเอียดการเพิ่มรายชื่อผู้ติดต่อ (Contacts)

4.3. การสร้างกลุ่มรายช่ือผู้ติดต่อใหม่

การสร้างกลุ่มรายช่ือผู้ติดต่อใหม่สามารถทำได้โดยคลิกเคร่ืองหมายบวก ตรงด้านขวามือในส่วนของ

ฟังก์ชัน Contacts และเลือก “New Contact Group”

รูปที่ 21 แสดงการสร้างกลุ่มรายชื่อผู้ติดต่อ (Contact Group)
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โดยใส่กลุ่มรายช่ือผู้ติดต่อท่ีต้องการในช่อง “Name” พร้อมคำอธิบายเพ่ิมเติมท่ีช่อง “Note” จากน้ัน

กรอกรายช่ือผู้ติดต่อท่ีต้องการ หรือคลิกเลือกรายช่ือผู้ติดต่อท่ีมีอยู่ เม่ือเพ่ิมรายช่ือท่ีต้องการเรียบร้อยแล้วคลิก

“Save” และคลิกเคร่ืองหมายกากบาทเพ่ือปิดหน้าต่างการเพ่ิมกลุ่มรายช่ือผู้ติดต่อ

รูปที่ 22 แสดงรายละเอียดการเพิ่มกลุ่มรายชื่อผู้ติดต่อ (Contact Group)

รูปที่ 23 แสดงรายละเอียดการเพิ่มกลุ่มรายชื่อผู้ติดต่อ (Contact Group)
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4.4. การใช้งานปฏิทิน

ปฏิทินและตารางนัดหมาย (Calendar and Schedule) สำหรับปฏิทินและตารางนัดหมายแล้วเปรียบ

เสมือนบันทึกช่วยจำในการจัดตารางเวลาท้ัง ในการทำงานและการบริหารทรัพยากรให้ได้อย่างมีประสิทธิภาพ

สามารถทำได้โดยการคลิกท่ีปุ่ม + ใน “Calendar” ซ่ึงอยู่ใน Menu Bar ด้านบนของ หน้าจอ Web mail

และเม่ือคลิกแล้วก็จะเข้าสู่กล่องข้อความปฏิทินและตารางนัดหมายหลัก ซ่ึงสามารถ

เลือกมุมมองของตารางนัดหมายเป็นวัน, สัปดาห์, เดือน, ตารางเวลา หรือโฟลเดอร์

รูปที่ 24 แสดงรายละเอียดการใช้งานปฏิทิน

การสร้างปฏิทินและตารางนัดหมายคลิกท่ีไอคอน + ของฟังก์ชัน Calendar เพ่ือเข้าสู่การสร้างตารางนัดหมาย

รูปที่ 25 แสดงรายละเอียดตารางนัดหมาย
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4.5. การนัดหมาย การเชิญประชุม และการเตือนความจำโดยใช้ปฏิทิน

การสร้างปฏิทินและตารางนัดหมายคลิกท่ีไอคอน + กรอกรายละเอียด และทำการคลิกไอคอน

เพ่ิมผู้ประชุม และทำการ Save

รูปที่ 26 แสดงรายละเอียดตารางเชิญประชุม

4.6. การเตือนความจำโดยใช้ปฏิทิน

การสร้างการเตือนความจำโดยใช้ปฏิทิน คลิกท่ีไอคอน + กรอกรายละเอียด ท่ีต้องการแจ้งเตือน และ

กำหนดการแจ้งเตือนก่อนการประชุมในส่วน Alarm เม่ือดำเนินการสร้างเรียบร้อยแล้วให้ทำการคลิก Save

รูปที่ 27 แสดงรายละเอียดการเตือนความจำโดยใช้ปฏิทิน

Subject ระบุหัวเร่ืองสําหรับการนัดหมาย
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Attendees ระบุผู้รับหรือผู้เข้าร่วมในตารางนัดหมายหลัก

Starts วันท่ีเร่ิมการนัดหมาย

Ends วันท่ีส้ินนสุดการนัดหมาย

Where สถานท่ีสําหรับนัดหมาย

Description คำอธิบายเพ่ิมเติม

Status สถานะของจดหมาย

Alarm  การแจ้งเตือน

4.7. การใช้กระเป๋าเอกสารในการจัดเก็บเอกสาร

เป็นส่วนการจัดการไฟล์ และแสดงไฟล์ท่ีเก็บในระบบสามารถอัพโหลดได้โดยคลิกท่ีปุ่ม ซ่ึงอยู่ในเม

นูด้านบนของหน้าจอแล้วเลือก Files

รูปที่ 28 แสดงรายละเอียดการใช้กระเป๋าเอกสารในการจัดเก็บเอกสาร
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โดยมีฟังก์ช่ันในเมนู File ดังน้ี

- Upload : ทำการอัพโหลดไฟล์จากในเคร่ืองคอมพิวเตอร์เข้าสู่ Web Mail

- Download : ทำการดาวน์โหลดไฟล์ท่ีมีอยู่ในรายการลงในเคร่ืองคอมพิวเตอร์

- Share link : ทำการแชร์ไฟล์ ผ่านลิงก์ให้เพ่ือนๆ ได้

- E-mail Link : ทำการแชร์ไฟล์ ผ่านลิงก์แล้วส่งเป็นอีเมลให้ผู้อ่ืนได้

- Move or Copy : ทำการย้าย หรือทำการ Copy ไปยังโฟลเดอร์อ่ืน

- Delete : ทำการลบไฟล์ท่ีเลือกไว้

นอกจากน้ีผู้ใช้ยังสามารถกำหนดสิทธ์ิให้ผู้ใช้อ่ืนสามารถเข้าดูหรือเพ่ิมเติมในแต่ละไฟล์ได้ โดยการคลิกขวา

ท่ีไฟล์ แล้วเลือก Access granted to…

รูปที่ 29 แสดงรายละเอียดการกำหนดสิทธิ์
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4.8. การแชร์โฟลเดอร์ส่วนตัว

ผู้ใช้งานสามารถกำหนด Share Folder ให้ผู้อ่ืนได้เลือกโฟลเดอร์ท่ีต้องการแชร์ และคลิก “Edit”

รูปที่ 30 แสดงรายละเอียดการแชรโ์ฟลเดอร์ส่วนตัว

กรอกอีเมลแอดเดรสท่ีต้องการแชร์ ในช่อง Access Control List โดยสามารถกำหนดสิทธ์ิในการเข้าถึง

เช่น Read, Write, Admin หรือ Custom (Lookup, Select, Seen, Flags, Insert, Create, Delete และ

Admin) จากน้ันคลิก “Save”

รูปที่ 31 แสดงรายละเอียดการแชรโ์ฟลเดอร์ส่วนตัว
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4.9. การรับ Share Folders จากผู้อ่ืน

หากผู้ใช้งานได้รับสิทธ์ิในการ Share folder จะได้รับจดหมาย Access Control List จากน้ันคลิก

“Subscribe”

รูปที่ 32 แสดงรายละเอียดการรับ Share Folders จากผู้อื่น

ระบบจะส่งไปยังหน้าต่าง Folder Subscription จากน้ันคลิก “Save”

รูปที่ 33 แสดงรายละเอียดการรับ Share Folders จากผู้อื่น
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4.10. ระบบเมลจะแสดงโฟลเดอร์ท่ีได้รับการ Share

รูปที่ 34 แสดงรายละเอียดการรับ Share Folders จากผู้อื่น
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บทท่ี 5

การต้ังค่าต่างๆ ใน Web Samoware

การต้ังค่าต่างๆ ในระบบ Web Samoware สามารถทำได้โดยการคลิกท่ีเมนู “Preferences” ท่ีเมนูด้านซ้ายมือ

รูปที่ 35 การตั้งค่าต่างๆ ในระบบ Web Samoware
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5.1. General

ในส่วนน้ี จะเป็นการต้ังค่าท่ัวไปของWeb mail โดยแบ่งออกเป็น Password, Devices, Sounds,

Access Control List

รูปที่ 36 แสดงการเมนูการตั้งค่า ส่วน General

สำหรับการต้ังค่าท่ัวไปของระบบ Web Samoware ผู้ใช้สามารถเลือกต้ังค่า ภาษา (Language), โซน

เวลา (Time Zone), Auto logout, พ้ืนท่ีการใช้งานอีเมล (Quota), เวอร์ช่ันระบบอีเมล, สกิน (Skin), ช่วยเหลือ

(Help)

รูปที่ 37 แสดงการตั้งค่าเมนู General
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5.1.1. Password

ผู้ใช้งานสามารถเปล่ียนรหัสผ่านเองได้โดย ใส่รหัสผ่านเดิม (Current Password) และรหัสผ่านใหม่

(New Password, Reenter Password) และคลิก “Apply”

รูปที่ 38 แสดงเมนูการเปลี่ยนรหัสผ่านอีเมล

5.1.2. Search

ระบบสามารถค้นหาข้อความ ได้ท้ังแบบภาษาไทยและภาษาอังกฤษ โดยการค้นหาจะแบ่งออกเป็น

Email, Calendar หรือ Contact

▪ วิธีการ Search Email สามารถทำการค้นหา ภาษาไทยและภาษาอังกฤษ
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รูปที่ 39 แสดงวิธีการ Search Email

▪ ตัวอย่าง ทดสอบค้นหาภาษาอังกฤษ

รูปที่ 40 แสดงวิธีการ ทดสอบค้นหาภาษาอังกฤษ

▪ ตัวอย่าง ทดสอบค้นหาภาษาไทย

รูปที่ 41 แสดงวิธีการ ทดสอบค้นหาภาษาไทย

▪ สามารถ Search ข้ันสูงท่ีอนุญาตให้ค้นหาพารามิเตอร์เฉพาะ เช่น “From”, “Subject” และตามช่วงวัน

ท่ีกำหนด
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รูปที่ 42 แสดงวิธีการสามารถ Search ขั้นสูง

▪ ตัวอย่าง การค้นหาด้วย From

รูปที่ 43 แสดงการค้นหาด้วย From
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รูปที่ 44 แสดงการค้นหาด้วย From
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▪ ตัวอย่าง การค้นหาด้วย Subject

รูปที่ 45 แสดงการค้นหาด้วย Subject

รูปที่ 46 แสดงการค้นหาด้วย Subject
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▪ ตัวอย่าง การค้นหาด้วย Cc

รูปที่ 47 แสดงการค้นหาด้วย Cc

รูปที่ 48 แสดงการค้นหาด้วย Cc
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▪ ตัวอย่าง การค้นหาด้วย Wildcard

รูปที่ 49 แสดงการค้นหาด้วย Wildcard

รูปที่ 50 แสดงการค้นหาด้วย Wildcard
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▪ วิธีการ Search Contact

รูปที่ 51 แสดงวิธีการ Search Contact

▪ buddies รายช่ือกลุ่ม หากมีคำยืนยันคำขอเป็นเพ่ือนกัน ท้ังสองฝ่ายสามารถเห็นทำใช้งานของกันและกัน

▪ contact รายช่ือกลุ่มท่ีติดต่อใหม่

▪ My domain รายช่ือผู้ติดต่อภายในโดเมน

▪ วิธีการ Search ไฟล์แนบ

กรณีค้นหาเป็นไฟล์แนบจะต้องทราบช่ือไฟล์ สามารถใส่บางค่าเพ่ือค้นหาได้

รูปที่ 52 แสดงวิธีการ Search ไฟล์แนบ
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5.1.3. Two-Factor Authentication

2FA เป็นการล็อกอินข้ันท่ี 2 หลังจากล็อกอินด้วยรหัสผ่านตามปกติ จะมีการยืนยันผ่านข้อความ SMS

บนโทรศัพท์สมาร์ทโฟน เพ่ือป้อนรหัสให้ตรงกัน และยืนยันตัวตน

- วิธีการต้ังค่าการใช้งาน Two-Factor Authentication โดยการส่งรหัสไปยังทางอีเมล

สามารถกำหนด Current Password และทำการกรอก Forgotten Password Recovery ใส่ราย

ละเอียดอีเมลท่ีต้องการส่งไปเพ่ือสามารถส่ง Confirmation code เพ่ือนำมากรอกเข้าระบบ

รูปที่ 53 แสดงการตั้งค่าการใช้งาน Two-Factor Authentication

5.1.4. Devices

เป็นเมนูแสดงรายละเอียดการเข้าใช้งานระบบอีเมล โดยระบุ Protocol, Login time, Login address,

Browser, Client name และ Platform

รูปที่ 54 แสดงรายละเอียดการเข้าใช้งานระบบอีเมล
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5.1.5. Sounds

ผู้ใช้งานสามารถเลือกเปิด/ปิดเสียงในระบบได้ผ่านเมนูน้ี

รูปที่ 55 แสดงเมนูการตั้งเปิด/ปิดเสียงในระบบ

5.1.6. Access Control List

ผู้ใช้งานสามารถให้สิทธ์ิผู้ใช้งานอ่ืนในระบบ ในการเข้าถึงข้อมูลได้โดย

รูปที่ 56 แสดงการตั้งค่าการเข้าถึงข้อมูล

Identifier ใส่ช่ือ account ท่ีต้องการให้สิทธ์ิในการเข้าถึงข้อมูล

Delegate ให้สิทธ์ิการเข้าถึงข้อมูล และสร้างโฟลเดอร์อีเมลย่อยได้

Call Control ให้สิทธ์ิการจัดการสายเรียกเข้า (Call)

Admin ให้สิทธ์ิการเข้าจัดการข้อมูลท้ังหมด

Create ให้สิทธ์ิในการสร้างโฟลเดอร์ได้
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5.2. Mail

ในส่วนน้ีเป็นการต้ังค่าเก่ียวกับเมล โดยแบ่งออกเป็น Rules, Trash Management, Remote POP,

Vacation message, Identities, Copy All Mail to และ Secure Mail การต้ังค่าเมลคือ การต้ังค่าต่างๆ ท่ีเก่ียว

กับจดหมาย ซ่ึงสามารถกำหนดรายละเอียดต่างๆ ได้ดังน้ี

รูปที่ 57 แสดงการตั้งค่าเมล

- Notify about new mail : การแจ้งเตือนเม่ือมีเมลใหม่

- Auto-save Every : การต้ังค่าเวลาในการบันทึกอัตโนมัติ

- Use HTML compose : ใช้รูปแบบ HTML ในการเขียนจดหมายใหม่

- Save recent addresses : บันทึกอีเมลท่ีมีการติดต่อ

- Show number of messages in mailbox : แสดงจำนวนข้อความใน mailbox

- Automatically notify when read : ส่งเมลแจ้งเตือนเม่ือผู้รับอ่านเมล

- Automatically notify when delivered : ส่งเมลแจ้งเตือนเม่ือปลายทางได้รับอีเมล

- Send Read Receipts : ส่งข้อความตอบกลับ เม่ือมีการอ่านข้อความ

- Mark As Read After : ทำสัญลักษณ์เม่ือมีการอ่านจดหมาย

- Store Drafts in : ต้ังค่าโฟลเดอร์เก็บข้อความร่าง

- Save Sent Messages in : ต้ังค่าโฟลเดอร์เก็บข้อความส่งออก

- Messages page size : จำนวนข้อความท่ีแสดงต่อหน้า

- Display Links : ต้ังค่าแสดงลิงก์

- Signature : ลายเซ็นแนบท้ายข้อความ

- Automatically Select Message : เลือกข้อความอัตโนมัติ
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- Forward messages inline : ตอบกลับข้อความในบรรทัด

- Hide images : ซ่อนรูปภาพ

- Multi-compost mode : ส่งข้อความแบบ Multi

5.3. การกำหนดข้อความลงท้ายอีเมล (Signature)

การกำหนดลายเซ็นสำหรับแนบท้ายอีเมลท่ีส่งออกไปหาผู้อ่ืน สามารถทำได้โดยคลิกท่ีปุ่ม

“Preferences” ใน Menu Bar จากน้ันเลือกแท็บ Mail ใน Sub menu เล่ือนลงข้างล่างจะเจอหัวข้อ

“Signature” ทำการเพ่ิมรายละเอียดข้อความท่ีต้องการ แล้วทำการบันทึก โดยคลิกท่ีปุ่ม Apply

รูปที่ 58 แสดงการตั้งค่าเมล

▪ วิธีการเปล่ียน Compose ใน Signature

รูปที่ 59 แสดงการวิธีการเปลี่ยน Compose ใน Signature
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5.4. วิธีการสร้าง Message Tags

รูปที่ 60 แสดงการวิธีการสร้าง Message Tags

- ทำการสร้าง Rule เข้าไปท่ี Preferences > Rules

- From is xxx*

- Action Mark Flagged,$Label1

รูปที่ 61 แสดงการวิธีการสร้างMessage Tags

Page 40



▪ ผลทดสอบ

รูปที่ 62 แสดงการวิธีการสร้างMessage Tags

5.4.1. Rules

เป็นการสร้างกฎเกณฑ์เพ่ือใช้ควบคุมและจัดการข้อความเข้าสู่ระบบ เพ่ือให้สามารถใช้งานได้ตามความ

ต้องการ ซ่ึงสามารถทำได้โดยคลิกเคร่ืองหมายบวก “Make Rule” จากน้ันต้ังช่ือ Rule ท่ีต้องการ (Name) พร้อม

ใส่คำอธิบายเพ่ิมเติม (Description)

รูปที่ 63 แสดงการตั้งชื่อกฎเกณฑ์ (Rules)

1) Data เป็นการกำหนดเง่ือนไขของข้อมูลท่ีปรากฎใน message ใดๆ

Data

From จาก(ผู้ส่ง)
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Data

Sender ผู้ส่ง

Return-Path E-Mail Address ท่ีส่งกลับ

To ถึง (ผู้รับ)

Cc สำเนา (ผู้รับ)

Any To or Cc ถึงทุกคน หรือ สำเนา (ผู้รับ)

Each To or Cc ถึงใครคนใดคนหน่ึง หรือ สำเนา (ผู้รับ)

Reply-To ตอบกลับถึง (ผู้รับ)

‘From’ Name จาก (ผู้ส่ง) ช่ือ

Subject หัวเร่ือง

Message-ID รหัส Message-ID

Message Size ขนาดของ Message

Time Of Day เวลาของ Message

Current Date วันปัจจุบัน (Monday, Tuesday, Wednesday, etc)

Current Day วันท่ีปัจจุบัน

Human Generated ถูกสร้างโดยบุคคล (ไม่ใช่คอมพิวเตอร์)

Header Filed ข้อความส่วนหัว Message

Any Recipient ผู้รับคนใดคนหน่ึง

Each Recipient ผู้รับคนใด

Existing Mailbox Mailbox ท่ีถูกสร้างข้ึนแล้ว

Source ข้อมูลต้นทาง

2) Action เป็นการกำหนดให้ระบบทำตามเง่ือนไข

Action Parameter

Store in เก็บข้อมูลใน ช่ือ Mailbox

Store Encrypted in เก็บข้อมูลท่ีได้ถูกเข้ารหัสใน ช่ือ Mailbox

Mark ทำสัญลักษณ์

Add Header เพ่ิมหัวข้อมูล ข้อมูล Header

Tag Subject เพ่ิมข้อความในหัวเร่ือง ข้อความ

Reject with ปฏิเสธด้วย ข้อความ

Discard ละเว้นการทำงานใดๆ
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Action Parameter

Store in เก็บข้อมูลใน ช่ือ Mailbox

Stop Processing หยุดการประมวลผล

Redirect To Redirect ไปยัง ผู้รับ

Forward To Forward ไปยัง ผู้รับ

Reply with ตอบกลับด้วย ข้อความ

ทำการสร้างเง่ือนไขท่ีต้องการ ซ่ึงสามารถกำหนดได้เอง โดยคลิกท่ี “Expert Mode” หรือสร้าง Rule

จากข้ันตอนของระบบ โดยคลิก “Next” เม่ือกำหนด Rule เรียบร้อยแล้วคลิก “Save Rule” เพ่ือใช้งาน

รูปที่ 64 แสดงการตั้งค่ากฎเกณฑ์ (Rules) แบบ Expert Mode

Add Rule ใส่ช่ือ Rule

Delete Marked ลบ Rule ท่ีเลือก

Priority ลำดับความสำคัญ หรือ ยกเลิกการใช้ช่ัวคราว

Name แสดงช่ือของ Rule ท่ีได้สร้างไว้แล้ว

Edit ปรับแต่ง Rule
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รูปที่ 65 แสดงการตั้งค่ากฎเกณฑ์ (Rules) แบบ Expert Mode

Comment ไว้สำหรับใส่เพ่ือความเข้าใจ

Data กำหนดเง่ือนไข

Operation ทำตามเง่ือนไข

Parameter (Data) ส่วนท่ีต้องการ

Action จากเง่ือนไข (Data) ให้ปฏิบัติ

Parameter (Action) ส่วนท่ีต้องการตาม Action
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ตัวอย่างการสร้าง Rules :

Ex1 – การ Move to Folder ท่ีกำหนด

รูปที่ 66 แสดงการทำ Rule ตามตัวอย่างที่ 1

Ex2 - การละเว้น (ไม่รับ) เมลท่ีไม่ถูกรูปแบบ

รูปที่ 67 แสดงการทำ Rule ตามตัวอย่างที่ 2
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Ex3 - การละเว้น (ไม่รับ) เมลท่ีให้ส่งกลับไปยัง info@domain.com

รูปที่ 68 แสดงการทำ Rule ตามตัวอย่างที่ 3

Ex4 - กรณีท่ีเมลท่ีส่งมาหลังจาก 8:15 am ให้ Redirect ไปยัง info@domain.com

รูปที่ 69 แสดงการทำ Rule ตามตัวอย่างที่ 4

Page 46

mailto:info@domain.com
mailto:info@domain.com


5.4.2. Trash Management

Trash Management เป็นการต้ังค่าจดหมาย ท่ีถูกลบและจดหมายขยะ โดยมีรายละเอียดการต้ังค่าดังน้ี

รูปที่ 70 แสดงการกำหนดจดหมายที่ไมต่้องการ และจดหมายขยะ

● Trash Management

Message Delete Method เลือกวิธีการลบข้อความ

- ทำสัญลักษณ์

- ย้ายไปไว้ในถังขยะ

- ลบทันที

Trash Folder ย้ายข้อความท่ีถูกลบไปยังโฟลเดอร์

Keep Message Received Time เก็บเวลารับข้อความ เม่ือย้ายไปโฟลเดอร์ท่ีกำหนดไว้

On Logout Remove from Trash if Older

than

ลบข้อความท่ีถูกลบท่ีเก่ากว่า เม่ือออกจากระบบ

● Junk Mail Control

Junk Folder ย้ายข้อความขยะไปยังโฟลเดอร์

On Logout Remove from Junk if Older

than

ลบข้อความขยะท่ีเก่ากว่า เม่ือออกจากระบบ
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5.4.3. Remote Poll

เป็นการดึงอีเมลจาก Account อ่ืนๆ มารวมเก็บไว้ท่ีเดียวกัน โดยใส่รายละเอียดอีเมล (E-mail), Server

Name และรายละเอียดการต้ังค่าต่าง ๆ ตามต้องการ และคลิก “Add”

รูปที่ 71 แสดงการตั้งค่า Remote POP

● การต้ังค่า POP

1. Users > Domain > <ช่ือโดเมนท่ีต้องการ> > Objects > <User ท่ีต้องการ> > Mail >

Remote Poll ตามรูปด้านล่าง

รูปที่ 72 แสดงการตั้งค่า Remote POP

ทำการกรอกข้อมูลตามด้านล่าง และกด Update

- Name ช่ือ Policy ท่ีต้องการต้ัง

- Poll Evert ระยะเวลาท่ีต้องให้ Server Sync ข้อมูล

- Account ช่ือ Account ท่ีต้องการ Sync

- At Host ช่ือ Host Mail ต้นทางท่ีต้องการเช่ือต่อ

- Leave เม่ือทำการลบ email จะไม่ลบ email ท่ีต้นทาง
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รูปที่ 73 แสดงการตั้งค่า Remote POP

2. เม่ือต้ังค่าเรียบร้อยแล้วจะได้รูปตามด้านล่าง

เปิด Browser ระบุ https://mail.pawn.co.th > Mail > Remote Poll

รูปที่ 74 แสดงการตั้งค่า Remote POP
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● การต้ังค่า IMAP

1. Users > Domain > <ช่ือโดเมนท่ีต้องการ> > Objects > <User ท่ีต้องการ> > Mail >

Remote Poll ตามรูปด้านล่าง

รูปที่ 75 แสดงการตั้งค่า IMAP

2. ทำการกรอกข้อมูลตามด้านล่าง และกด Update

- Name ช่ือ Policy ท่ีต้องการต้ัง

- Poll Evert ระยะเวลาท่ีต้องให้ Server Sync ข้อมูล

- Account ช่ือ Account ท่ีต้องการ Sync

- At Host ช่ือ Host Mail ต้นทางท่ีต้องการเช่ือมต่อ

รูปที่ 76 แสดงการกรอกข้อมูล
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3. เม่ือต้ังค่าเรียบร้อยแล้วจะได้รูปตามด้านล่าง

เปิด Browser ระบุ https://mail.pawn.co.th > Mail > Remote Poll > IMAP

รูปที่ 77 แสดงเมื่อตั้งค่าเรียบร้อยแล้ว

5.4.4. จัดการอีเมลขยะ

เป็นการกําหนดการกระทําของแต่ละอีเมลท่ีมีความเป็นไปได้ว่าจะเป็นอีเมลขยะสูง, ปานกลาง หรือต่ํา ซ่ึง

ทําได้โดยการคลิกท่ีปุ่ม ‚Junk Mail Control และคลิกท่ีปุ่ม เพ่ือ อัพเดทการต้ังค่า

รูปที่ 78 รูปแสดงการจัดการอีเมลขยะ
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5.4.5. Vacation Message

เป็นการสร้างข้อความตอบกลับอัตโนมัติกรณีท่ีไม่สามารถตอบกลับข้อความได้หรืออยู่ในช่วงลาพักงาน

(Vacation) โดยสามารถเปิดใช้โดย Enable “Vacation Message enabled”

รูปที่ 79 แสดงการเปิดใชง้าน Vacation Message

ทำการกำหนดวันเร่ิมใช้งาน (Starts) และวันส้ินสุด (Ends) พร้อมระบุวันท่ี จากน้ันกรอกข้อความตอบ

กลับอัตโนมัติท่ีต้องการ (Text) หากต้องการให้มีการแจ้งเตือนไปยังบุคคลอ่ืนๆ ให้ Enable Notify และกรอกอี

เมลท่ีต้องการ จากน้ันคลิก “Apply” เพ่ืออัพเดทการต้ังค่า โดยแนะนำให้คลิก “Clear” ทุกคร้ังท่ีมีการต้ังค่า

Vacation Message เพ่ือลบข้อมูลอีเมลท่ีมีการส่งถึงแล้ว

รูปที่ 80 แสดงการตั้งค่าใชง้าน Vacation Message
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5.4.6. Identities

เป็นการกำหนดช่ือ Account เพ่ือใช้งาน เช่น ไว้ใช้ในการส่งอีเมล เม่ือกำหนดค่าเรียบร้อยแล้ว ให้คลิก

“Save” และ “Apply” เพ่ืออัพเดทการต้ังค่า

รูปที่ 81 แสดงการตั้งค่า Identities

5.4.7. Copy All Mail to

เป็นการต้ังค่าคัดลอกอีเมลไปยัง Account ท่ีต้องการ โดยสามารถเปิดใช้โดย Enable “Copy All Mail

To”

รูปที่ 82 แสดงการเปิดใช้งาน Copy All Mail To
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รูปที่ 83 แสดงการตั้งค่าใช้งาน Copy All Mail To

E-mail คัดลอกข้อความไปยังอีเมล

Keep the Original เก็บข้อความไว้

Do not Copy Automatic Messages ไม่ต้องคัดลอกข้อความส่งอัตโนมัติ

Action เลือกวิธีคัดลอกข้อความ

- ส่งด้วยช่ือผู้ต้ังค่า

- เก็บช่ือผู้ส่ง

- เก็บช่ือผู้ส่ง และผู้รับ
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5.4.8. การใช้งาน Secure Mail (S/MIME)

การเข้ารหัสคีย์ใช้สำหรับลงลายมือช่ืออิเล็กทรอนิกส์ (ลายเซ็นดิจิตอล) และการเข้ารหัสอีเมล เพ่ือเพ่ิม

ระดับความปลอดภัย ช่วยปกป้องข้อมูลและรักษาข้อมูลท่ีเป็นความลับให้กับ Account ผู้ใช้งาน

รูปที่ 84 แสดงการตั้งค่าใช้งาน Secure Mail

รูปที่ 85 แสดงตัวอย่างได้รับอีเมลที่ถูกตั้งค่าโดย Secure Mail
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5.4.9. Contact

เป็นการเพ่ิมท่ีอยู่การติดต่อ โดยระบุช่ือท่ีอยู่ไดเรกทอรีและฐานการค้นหา (ค้นหา DN) จากน้ันคลิก

“Apply”

รูปที่ 86 แสดงการตั้งค่า Directory Address Books

5.4.10. การต้ังค่าปฏิทิน (Calendar)

เป็นการต้ังค่าปฏิทินในระบบอีเมล ซ่ึงสามารถกําหนดปฏิทินหลัก,

กําหนดการแบ่งเวลาเป็นคาบของปฏิทิน, กําหนดมุมมองของตารางในปฏิทิน, กําหนดวันเร่ิมในสัปดาห์,

กําหนดช่ัวโมงการทํางาน, กําหนดจํานวนวันของข้อมูลสถานะว่าง/ไม่ว่างท่ีจะปรากฎบนอินเทอร์เน็ตจากน้ันจึง

ทําการอัพเดทค่าท่ีเปล่ียนแปลง
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รูปที่ 87 แสดงการเข้าตั้งค่าปฏิทิน (Calendar)

5.5. การใช้งานปฏิทิน

5.5.1. ปฏิทินและตารางนัดหมาย (Calendar and Schedule)

สำหรับปฏิทินและตารางนัดหมายแล้วเปรียบเสมือนบันทึกช่วยจำในการจัดตารางเวลาท้ัง ในการทำงาน

และการบริหารทรัพยากรให้ได้อย่างมีประสิทธิภาพ

- สามารถทำได้โดยการคลิกท่ีปุ่ม + ใน “Calendar” ซ่ึงอยู่ใน Menu Bar ด้านบนของหน้าจอ

Web mail และเม่ือคลิกแล้วก็จะเข้าสู่กล่องข้อความปฏิทินและตารางนัดหมายหลัก ซ่ึง

สามารถเลือกมุมมองของตารางนัดหมายเป็นวัน, สัปดาห์, เดือน, ตารางเวลา หรือโฟลเดอร์

รูปที่ 88 แสดงการสร้างปฏิทิน (Calendar)

การสร้างปฏิทินและตารางนัดหมายคลิกท่ีไอคอน + ของฟังก์ชัน Calendar เพ่ือเข้าสู่การสร้างตารางนัดหมาย

รูปที่ 89 แสดงการสร้างปฏิทิน (Calendar)
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เม่ือดำเนินการสร้างเรียบร้อยแล้ว จะได้ตัวอย่างตามด้านล่าง

รูปที่ 90 แสดงผลลัพธ์ (Calendar)

5.5.2. การนัดหมาย การเชิญประชุม และการเตือนความจำโดยใช้ปฏิทิน

การสร้างปฏิทินและตารางนัดหมายคลิกท่ีไอคอน + กรอกรายละเอียด และทำการคลิกไอคอน

เพ่ิมผู้ประชุม และทำการ Save

รูปที่ 91 แสดงการสร้างปฏิทิน (Calendar)
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เม่ือดำเนินการสร้างเรียบร้อยแล้ว จะได้ตัวอย่างตามด้านล่าง

รูปที่ 92 แสดงการสร้างปฏิทิน (Calendar)

5.5.3. การเตือนความจำโดยใช้ปฏิทิน

การสร้างการเตือนความจำโดยใช้ปฏิทิน คลิกท่ีไอคอน + กรอกรายละเอียด ท่ีต้องการแจ้งเตือน และ

กำหนดการแจ้งเตือนก่อนการประชุมในส่วน Alarm เม่ือดำเนินการสร้างเรียบร้อยแล้วให้ทำการคลิก Save

รูปที่ 93 แสดงการสร้างปฏิทิน (Calendar)
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5.6. การใช้กระเป๋าเอกสารในการจัดเก็บเอกสาร

เป็นส่วนการจัดการไฟล์ และแสดงไฟล์ท่ีเก็บในระบบสามารถอัพโหลดได้โดยคลิกท่ีปุ่ม ซ่ึงอยู่ในเม

นูด้านบนของหน้าจอแล้วเลือก Files

รูปที่ 94 การใชก้ระเป๋าเอกสารในการจัดเก็บเอกสาร

Private เป็น folder สำหรับเก็บข้อมูลส่วนตัว

Pubcal เป็น virtual folder ท่ีระบบสร้างข้ึน ข้อมูลในโฟลเดอร์น้ี จะเป็น virtual file ท่ีสร้างจากข้อมูล

ของผู้ใช้ โดยมีฟังก์ช่ันในเมนู File ดังน้ี

- Upload: ทำการอัพโหลดไฟล์จากในเคร่ืองคอมพิวเตอร์เข้าสู่ Web Mail

- Download: ทำการดาวน์โหลดไฟล์ท่ีมีอยู่ในรายการลงในเคร่ืองคอมพิวเตอร์

- Share link: ทำการแชร์ไฟล์ ผ่านลิงก์ให้เพ่ือนๆ ได้

- E-mail Link: ทำการแชร์ไฟล์ ผ่านลิงก์แล้วส่งเป็นอีเมลให้ผู้อ่ืนได้

- Move or Copy: ทำการย้าย หรือทำการ Copy ไปยังโฟลเดอร์อ่ืน

- Delete: ทำการลบไฟล์ท่ีเลือกไว้

นอกจากน้ีผู้ใช้ยังสามารถกำหนดสิทธ์ิให้ผู้ใช้อ่ืนสามารถเข้าดูหรือเพ่ิมเติมในแต่ละไฟล์ได้ โดยการคลิกขวา

ท่ีไฟล์ แล้วเลือก Access granted to…
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รูปที่ 95 แสดงการเลือก Access granted to…

5.6.1. วิธีการ Import iCal ผ่านหน้า webmail

ไปยัง Calendar > เมนู > Import Calendar Data > Open

รูปที่ 96 แสดงการ Import iCal

5.6.2. วิธีการ Export iCal ผ่านหน้า mail Client

1. Outlook ให้เปิดปฏิทิน แล้วเลือกปฏิทินท่ีคุณต้องการส่งออก

Page 61



2. Click File > Save Calendar

รูปที่ 97 แสดงวิธีการ Outlook ให้เปิดปฏิทิน แล้วเลือกปฏิทินทีคุ่ณต้องการส่งออก

รูปที่ 98 แสดงวิธีการ Click File > Save Calendar
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5.7. การต้ังค่า Chat

เป็นการต้ังค่า Chats ในระบบ Web Samoware ซ่ึงสามารถกําหนดการบันทึกการสนทนา (Auto-save

Chats) และการกําหนดท่ีอยู่ของ Chat จากน้ันจึงทําการอัพเดทค่าท่ีเปล่ียนแปลง

รูปที่ 99 แสดงการตั้งค่า Chat

รูปที่ 100 แสดงการ Auto-save Chats
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5.8. ระบบงาน (Tasks)

สามารถทำได้โดยการคลิกไปยัง Tasks และเม่ือคลิกแล้วก็จะเข้าสู่กล่องข้อความระบบงานหลัก

คลิกท่ีไอคอน + กรอกรายละเอียดของ Tasks งาน

รูปที่ 101 แสดงระบบงาน (Tasks)

To ระบผุูรั้บหรอืผูเ้ขา้รว่มในงาน
Summary หวัเรือ่งของงาน
Attachments ระบไุฟลแ์นบทีต่อ้งการสง่
Starts วนัที่ (เริม่) งาน
Due วนัสิน้สดุงาน
Private สถานนะความเป็นสว่นตวั
Percent เปอรเ์ซน็ตข์องงานทีส่ำเร็จแลว้
Message ขอ้ความสว่นตวั
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รูปที่ 102 แสดงระบบงาน (Tasks)
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บทท่ี 6

การกำหนดค่า Share Folders ใน Web Samoware

6.1. การกำหนด Share Folders ให้ผู้อ่ืน

1. ผู้ใช้งานสามารถกำหนด Share Folder ให้ผู้อ่ืนได้เลือกโฟลเดอร์ท่ีต้องการแชร์ และคลิก “Edit”

รูปที่ 103 แสดงการกำหนด Share Folder

กรอกอีเมลแอดเดรสท่ีต้องการแชร์ ในช่อง Access Control List โดยสามารถกำหนดสิทธ์ในการเข้าถึง

เช่น Read, Write, Admin หรือ Custom (Lookup, Select, Seen, Flags, Insert, Create, Delete และ

Admin) จากน้ันคลิก “Save”

รูปที่ 104 แสดงการเลือกอีเมลแอดเดรสและกำหนดสิทธิ์การเข้าถึง
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6.2. การรับ Share Folders จากผู้อ่ืน

1. หากผู้ใช้งานได้รับสิทธ์ิในการ Share folder จะได้รับจดหมาย Access Control List จากน้ัน

คลิก “Subscribe”

รูปที่ 105 แสดงการได้รับจดหมาย Access Control List จากการ Share folder

2. ระบบจะส่งไปยังหน้าต่าง Folder Subscription จากน้ันคลิก “Save”

รูปที่ 106 แสดงการบันทึก Folder Subscription

3. ระบบเมลจะแสดงโฟลเดอร์ท่ีได้รับการ Share

รูปที่ 107 แสดงโฟลเดอร์ของผู้อื่น
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6.3. วิธีการ Share Address Books (Contacts)

ไปยัง Contacts > Address Books > เมนู > Access Control List > กรอกอีเมลท่ีต้องการให้

สิทธ์ิ > กำหนดสิทธ์ิ > save

รูปที่ 108 แสดงการ Share Address Books

รูปที่ 109 แสดงการ Share Address Books
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รูปที่ 110 แสดงการ Share Address Books

6.4. การใช้งาน Buddies

รายช่ือ Buddies จะเป็นบัญชีรายช่ือสามารถกำหนดให้กับกลุ่มบัญชีรายช่ือหน่ึงหรือหลายกลุ่ม เม่ือผู้ใช้

บัญชีเพ่ิมบัดด้ีลงในบัญชีรายช่ือ รายช่ือจะถูกส่งไปยังท่ีอยู่บัดด้ี หากผู้รับยืนยันคำขอน้ี "เป็นเพ่ือน" สถานะบัดด้ีใน

ข้อมูลสถานะบัญชีรายช่ือจะกลายเป็น "ยืนยัน" และท้ังสองฝ่ายสามารถเห็นสถานะการแสดงตนของกันและกันได้

รูปที่ 111 แสดงการ การใชง้าน Buddies
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